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This Word layout template for Help & Manual defines the entire layout 
- front page, table of contents, chapter headings, keyword index. 
To customize this template, use the original file ("Word-Template-
A4.docx") from the H&M installation folder, make a copy of it, then tai-
lor it with MS Word to your requirements. You can use variables in 
every place of the document. To insert a variable, insert a COMMENT 
field in Word, then type the variable name as the field content. Like the 
field above this text. 
Move on to the next page in this document to customize the table of 
contents (a placeholder for the real TOC later) and modify text and par-
agraph format of the chapter headings in the middle of this template. 
You might also want to change the numbering style. 
 
Important: before you use the template for publishing in H&M, make 
sure that general page format and margins are set correctly. H&M will 
export images and tables to make them fit in the space available. 

MORC CREATIONS SOFTWARE  
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1. INTRODUCTION 

My Novel Writer software application allows you to plan and manage the writing of Nov-
els, Books and Plays. This easy-to-use application has a modern interface consisting of 
a range of highly functional and useful tools.  
 

Functionality included within the My Novel Writer includes: 
 

• the Creation and Manage of books, novels and scripts of any type 

 

• a Book Outliner which allows you to build and manage the outline of your book all in 
one place 

 

• a Character Profiler which allows you to create and manage full character profiles for 
each of your characters, including the addition of images and the use of character pro-
file templates if so desired,   

 

• an Event Sequence Builder which allows for the creation of events within your books.  
 

• an Object Manager which allows for the creation of objects. 
 

• a Location Manager which allows for the creation and management of locations which 
occur within your book. 

 

Below is shown an instance of the Book Outliner screen containing a book which con-
sisting of both front and back pages along with multiple chapters and subsections within 
the books structure. 
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2. LICENSING 

When you first start your copy of the My Novel Writer application you will be presented 
with the License Key screen, as shown in the image below.  
 

 
 

If you do not have a license key then press the Request License Key button and the en-
ter your details and email these to MORC Creations and we will email you back your My 
Novel Writer License key.  
 

If you already have your license key, then enter it into the License Key field and press 
the Save button. If the license key is valid then you will be able to log into the application 
and be able to access all of the My Novel Writer functionality. If you enter an invalid li-
cense key then an error message will be displayed and you will not have full access to 
the My Novel Writer software. 
 

If you do not yet have a license key then you can simply run the application in trial mode. 
In this mode you will still be able to access all areas of the application, but you will not 
be able to save any of the items you create.  
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3. LOGIN 

The My Novel Writer user login screen is shown below. This screen allows you to login 
into the My Novel Writer application.  
 

You must enter both a valid user name and matching password to login. Press the Show 
Password toggle button to see you password as plain text. You can also optionally se-
lect a book to automatically open in the Nook Outliner when you login. If you select the 
"<None>" option then no book will be opened at login time. 
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4. APPLICATION MENU 

The My Novel Writer application menu is access from the Pen icon in the top left hand 
corner of the screen, as shown below. 
 
 

 
 

This menu contains only two menu items: 
 

• About My Novel Writer: The About My Novel Writer menu option , when selected dis-
plays the application about screen. 

 

• Exit: The Exit menu option, when clicked closes the My Novel Writer application. 
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5. MY NOVEL WRITER RIBBON BAR 

The My Novel Writer Ribbon Bar sits at the top of the main application screen an provides ac-
cess to all the functionality available within the My Novel Writer application. 
 
 

 
 

 

The Ribbon Bar contains 5 main tabs, these being: 
 

• Book: The Book tab provides access to all functionality related to creating and manag-
ing your book such as Open Book, Story Board, and Create New Book. For further in-
formation see the Book Tab help section. 

 

• View: The View tab provides access to all your secondary forms such as the Book 
Outliner, Character Profile Builder and Event Sequence Builder. For further information 
see the View Tab help section. 
 

• Tools: The Tools tab provides access to tools such as template  builder and task list 
tracker. For further information see the Tools Tab help section. 
 

• Administration: The Administrations tab provides access to the systems options and 
user management areas a well at management iof task status and categories lists. For 
further information see the Administration Tab help section. 
 

• External Tools: The External Tools tab allows you to add and manage external tools. 
Using this functionality you can link the My Novel Writer application to other external 
applications and then access then directly from this tab. For further information see the 
External Tools Tab help section. 

5.1. BOOK TAB 

The My Novel Writer Book tab provides access to all functionality related to creating and 
managing your book such as Open Book, Story Board, and Create New Book. The Book 
tab is shown in the image below. 
 



My Novel Writer - (version 2.0)  Page 10  

 
 
 

The Book Tab Contains 3 main groups and 8 buttons, these being: 
 

Book Management Group 

 

The Book Management groups contains functionality to create and manage your books. 
This functional group contains the following buttons: 
 

• Open Book: The Open Book functionality allows you to open existing My Novel Writer 
books. 

 

• Open Story Board: The Open Story Board functionality allows you to create full story 
boards for you book. 

 

• Create New Book: The Create New Book functionality allows for the creation of new 
books within the My Novel Writer application. 

 

• Manage Books: The Manage Books functionality allows you to manage existing books 
within the My Novel Writer application. 

 

• Close Book: When the Close book button is pressed the currently selected book ill be 
closed. 
 

 

Book Properties Group 

 

The Book Properties groups contains functionality to manage the properties of your 
book. This group contains two buttons, these being: 
 

• Book Properties: The Book Properties functionality allows you to review and manage 
your book properties. 
 

• Book Note Cards: The Book Note Cards functionality allows you to review and man-
age which note card types have been assigned to your book. 
 

 

Help Group 

 

The Help group contains only one button the Help button. When this button is pressed 
the My Novel Writer Help is opened.  
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5.1.1. OPEN BOOK 

The Open Book screen is illustrated below. 
 

 
 
 

Use this screen to select and open an existing book within the My Novel Writer applica-
tion. Simply select the book you wish to open from the list, as shown above, and click 
the open button. Alternatively you can also use the right mouse click context menu, as 
shown below. Once you have selected a book and pressed the Open button then the se-
lected book will automatically be opened in the Book Outliner screen. 
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5.1.2. OPEN STORY BOARD 

The Storyboard screen is illustrated below. You can use this screen to map out your 
story scene by scene or item by item.  
 
 
 

 
 

Along the top of the storyboard screen their are 4 main buttons, there being: 
 

 Add Storyboard Card - This functionality allows you to add a new Storyboard 
Card to the board. When pressed this button automatically adds a new blank storyboard 
card to the board, as shown below. 
 
 

 
 

Double click on the Storyboard Card title text to open the Storyboard Item Title screen, 
as shown below. Use this screen to change the title text as desired.  
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Click inside the card to enter summary information about the item, as shown below, 
 

 
 

If you wish to add a more complete description of the scene then double click the text 
area and the central of the storyboard card and the Storyboard Card Text Editor will 
open, as shown below. Use the Save button at the top of the screen to save the text you 
enter into this screen. 
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 Delete Storyboard Card Button - This functionality allows you to add a delete 
the currently selected Storyboard Card. 
 
 

  Move Storyboard Card Left - This functionality allows you to move the currently 
selected Storyboard Card one place to the right. 
 
 

 Move Storyboard Card Right - This functionality allows you to move the cur-
rently selected Storyboard Card one place to the left. 
 
 
 

5.1.3. CREATE BOOK 

The Create Book screen is shown below. Use this screen to create new books within the 
My Novel Writer application.  
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Enter the following details for the new book: 
 

• Book Title 

 

• Book Author 
 

• Password (optional) 
 

• Select the Book Genre or add a new genre using the Add Genre button 

 

Press the Create button to create the new book or the Cancel button to cancel and close 
this screen. 

5.1.4. MANAGE BOOKS 

+T+he Manage books screen is shown below. Use this screen to manage existing books 
created within the My Novel Writer application.  
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After selecting the book in the existing book list you have the options to: 
 

• Open the Book 

 

• Rename The Book 

 

• Delete The Book 

 
 

These options are also available from the right context menu of the list, as shown below. 
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5.1.5. BOOK PROPERTIES 

The Book Properties screen is shown below. There are two tabs contained on this scree; 
the Book Properties tab and the Book Synopsis tab. 
 

Book Properties Tab 

 

The Book Properties tab allows for the management of the following information: 
 

• Authors Name 

 

• Book Title 

 

• Book Genre  
 

• Summary Sentence 

 

 
 
 
 

Book Synopsis Tab 

 

The Book Synopsis tab, as shown below, allows for the entry of an overview synopsis of 
the book. 
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5.1.6. BOOK NOTECARDS 

The Book Note Cards screen is shown below. Use this screen to allocated exiting book 
note cards to your book. If you need to craete new book cards use the Notecard Types 
functionality. 
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The list at the top of the screen displays the available note cards while the list at the bot-
tom of the screen displays the note cards which have already been assigned to your 
book. You may assign up to 12 note cards to any particular book.  
 

To add a note card to your book select the desired note card in the list at the top of the 
screen and then press the Add To Book button, the note card will automatically be 
moved into your book.  
 

To remove a note card from your book select the desired note card in the list at the bot-
tom of the screen and then press the Remove From Book button, the note card will auto-
matically be removed from your book and placed back in the available note card list. 
 

Use the Move Up and Move Down buttons top reorder the note cards within your book.  
 

Press the Save button to save the book note card configuration when you are happy 
with the layout. 

5.1.7. HELP 

The Help button is available from  the Book Tab within My Novel Writer. When pressed 
this button opens the My Novel Writer help system, as shown below, 
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The Help Window provides three main tabs: 
 

Contents: Which provides a structured table of contents into the My Novel Writer Help 

 

Search: Allowing you to search the help for a specific help term, 
 

Favorites; Allowing you to access items saved a your favorites from within the My Novel 
Writer help system. 
 

5.2. VIEW TAB 

The My Novel Writer View tab provides access to all your secondary forms such as the 
Book Outliner, Character Profile Builder and Event Sequence Builder. This tab is shown 
below. 
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The View Tab Contains 2 main groups and 9 buttons, these being: 
 

Main Forms 

 

The Main Forms groups contains functionality to aid in the creation of your books. This 
functional group contains the following buttons: 
 

• Book Outliner: The Book Outliner screen allows you create and manage your book's 
outline. From this screen you can selective open chapters and sections within your 
book and use the page editor to create more detailed information, including adding ad-
ditional information to each of your note cards. See the Book Outiner help section for 
more details. 
 

• Characters: The Character button, when pressed opens the Character Profiler screen. 
This screen allows you to create detailed character profile using optional character 
templates and includes the ability to add character images and additional character in-
formation pages to each character. See the Characters help section for further details. 
 

• Event Sequence Builder:  
 

• Objects 

 

• Locations 

 
 

Accessory Forms 

 

The Accessory Forms groups contains additional functionality which may be useful dur-
ing the creation and planning of your book. This functional group contains the following 
buttons: 
 

• Research Manager 
 

• Glossary 

 

• Text Snippets 

 

• Project Ideas 

5.2.1. BOOK OUTLINE 
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The Book Outline screen is shown in the image below. This screen allows you to create 
and manage the structure of your book. From this screen you can add, rename and re-
move pages and chapters from your book or even reorder pages or whole sections by 
simply dragging and dropping them within the structure. 
 

 
 

 
 

When pressed the Front / Back Pages button opens a screen through which you can 
manage what appears in the front and back page sections of your book. This may range 
from no pages at all through to a whole range of different page types, as shown in 
the image below. You have complete control over these page sets and may add or de-
lete pages to either section as required.  
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When you double click on a page within the Book Outliner you are presented with the 
Page Editor. From this screen you enter detailed text and images relating to the book 
page you have selected. The Page Editor screen also provides speech functionality, if 
available on your computer. This speech functionality includes the ability to start, stop, 
pause and resume speaking of the text you have entered into the editor section of the 
screen. 
 

The Page Editor screen also provides access to Resource Items and allows you to enter 
information into the Note Cards you have assigned to this book. The Note Cards are dis-
played at the bottom of the editor screen and may be hidden or displayed using the first 
button on the editors toolbar.  
 

The Resources tab at the bottom of the screen allows you to add and remove Resource 
items or Information relating to this page or scene. The Note Cards, the format of which 
is defined through the Note Cards Templates screen and those of which are selected for 
this book via the Book Note Cards screen, as shown in the screen image below. 
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5.2.2. CHARACTERS 

The Character Profiles screen is shown below. This screen allows you to define charac-
ters who will appear in you novel, play or book. For each character you create you may 
also nominate one or more information pages about that character, such as their friends, 
favorite haunts or anything else you wish to add.  
 

As can be seen from the image below, a simple editor allows you to format the infor-
mation about you character in anyway you wish, including text formatting, size and col-
our and the addition of any images you may wish to include. 
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5.2.3. EVENT SEQUENCE BUILDER 

The Event Sequence Builder screen allows you to define events which will occur within 
your novel, play or book. For each event you created may define the event name and its 
details. You may also nominate one or more information pages about that event.  
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As can be seen in the image below a simple editor at the top of the screen allows you to 
format the information about your event in anyway you wish, including text format-
ting, size and colour and the addition of any images you may wish to include. 
 

 
 

When you create new events you may nominate to use an event sequence template to 
define the event. Event Sequence Templates are managed by you within the My Novel 
Writer application through the Event Sequence Template screen, as show below. 
 

Using this screen you can add, rename or delete Event Sequence Templates and format 
the text of the template to your liking using the editor toolbar. 
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5.2.4. OBJECT MANAGER 

The Object Manager screen is shown below. You can use this screen to define objects 
which exists within your novel or play. 
 

For each Object item you create you may define the object name and details. In addi-
tion you may also create multiple information pages about that object. As can be seen in 
the image below a simple editor located at the top of the screen allows you to format the 
information about your object in anyway you wish, including text formatting, size and col-
our and the addition of any images you may wish to include. 
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When you create new Object items within the My Novel Writer application you may also 
select to use an Object Template to define the initial object information. Object Tem-
plates are managed by you within the My Novel Writer software through the Object 
Types Template screen, as show below.  
 

Using this form you can add, rename or delete Object Type Templates and format 
the text of the template to your liking using the editor toolbar at the top of the screen. 
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5.2.5. LOCATION MANAGER 

The Location Manager screen, as shown below, allows you to define the various loca-
tions which will appear within your novel, play or book.  
 

For each location which you define you may enter the name and details of the location. 
In addition you may also create multiple information pages about that location. As with 
all the item management forms you may group your locations into folders for ease of 
management and handling. As can be seen in the image below a simple editor allows 
you to format the information about you location in anyway you wish, including text for-
matting, size and colour and the addition of any images you may wish to include. 
 



My Novel Writer - (version 2.0)  Page 30  

 
 
 
 

When you create new Locations within the My Novel Writer application you may nomi-
nate to use a Location Type Template to help define or format the presentation of the 
the location information. Location Type Templates are managed by you within the My 
Novel Writer application through the Location Type Template screen, as show below.  
 

Using this screen you can add, rename or delete Location Type Templates and format 
the text of the template to your liking using the editor toolbar. 
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5.2.6. RESEARCH MANAGER 

The Research Manager screen is shown below and is used to enter and manage all 
your research information. The Research Manager is a single screen which allows for 
both tree navigation and management and item entry and editing all in the one screen. 
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The available toolbar items on the Research Manager screen are: 
 

 Save Button - The Save Button allows your to save the text you have entered for 
the current Research item. 
 

 Undo Button - The Undo Button allows you to undo your previous actions. You may 
press the undo button multiple times to undo multiple actions you have performed in the 
text box. 
 

 Redo Button - The Redo Button allows you to Redo actions you have previously 
undone. You may press the redo button multiple times to redo multiple actions you have 
undone in the text box. 
 

 Copy Button - The Copy Button allows you to copy any item which has been high-
lighted in the text box. . 
 

 Cut Button - The Cut Button allows you to cut any item which has been highlighted 
in the text box. The cut item is also stored on the clipboard so you can paste it else-
where if you wish.  
 

 Paste Button - The Paste Button allows you to paste any item which has previously 
been copied or cut from the text.  
 

 Bold Button - The Bold  Button is a toggle button you allows you to make highlighted 
text bold. When selected text is already bold or the bold button is pressed the button will 
appear in pressed mode. 
 

 Italic Button - The Italic Button is a toggle button you allows you to make highlighted 
text italic. When selected text is already italic or the italic button is pressed the button will 
appear in pressed mode. 
 

 Strike Thru Button - The Strike Thru Button is a toggle button you allows you to 
make highlighted text Strike Thru. When selected text is already in strike thru or the 
strike thru button is pressed the button will appear in pressed mode. 
 

 Underline Button - The Underline Button is a toggle button you allows you to make 
highlighted text Underlined. When selected text is already underlined or the underline 
button is pressed the button will appear in pressed mode. 
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 Superscript Button - The Superscript Button is a toggle button you allows you to 
make highlighted text Superscript. When selected text is already superscript or the su-
perscript button is pressed the button will appear in pressed mode. 
 

 Subscript Button - The Subscript Button is a toggle button you allows you to make 
highlighted text Subscript. When selected text is already in subscript or the subscript 
button is pressed the button will appear in pressed mode. 
 
 

 Font Style and Size Drop Down Lists  - 
The Font Style and Size drop down lists allow you to select the font style and size of 
your text. 
 

 Increase and Decrease Font Size Buttons - The Increase and Decrease Font 
Size buttons allow you to change the size of your selected font by one size for every 
press of the button. 
 

 Image Button - The Image button allows you to select and image to insert into the 
text box at the current cursor location.  
 

 Centre Text Button - The Centre Text button allows you to centre text within the 
text box  
 

 Left Align Text Button - The Left Align Text button allows you to left align text 
within the text box  
 

 Right Align Text Button - The Right Align Text button allows you to right align text 
within the text box  
 

 Bullet List Button - The Bullet List button converts highlighted text into a bullet text 
list. 
 

 Numbered List Button - The Numbered :List button converts highlighted text into a 
numbered text list. 
 

 Font Colour Button - The Font Colour button allows you to select the colour of the 
text. This applies to both highlighted text and text that you will place in at the current cur-
sor position. When this button is pressed  the colour selection panel is displayed from 
which you may select the desired colour. 
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 Font Background Colour Button - The Font Background Colour button allows you 
to select the background colour of the text. This applies to both highlighted text and text 
that you will place in at the current cursor position. 
 

5.2.7. GLOSSARY 

The Glossary screen is shown below and is used to enter and store terminology relevant 
to your book or novel. The Glossary is a single screen which allows for both tree naviga-
tion and management and item entry and editing all in the one screen. 
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The available toolbar items on the Glossary form are: 
 

 Save Button - The Save Button allows your to sav th text you have entered for the 
current glossary item. 
 

 Undo Button - The Undo Button allows you to undo your previous actions. You may 
press the undo button multiple times to undo multiple actions you have performed in the 
text box. 
 

 Redo Button - The Redo Button allows you to Redo actions you have previously 
undone. You may press the redo button multiple times to redo multiple actions you have 
undone in the text box. 
 

 Copy Button - The Copy Button allows you to copy any item which has been high-
lighted in the text box. . 
 

 Cut Button - The Cut Button allows you to cut any item which has been highlighted 
in the text box. The cut item is also stored on the clipboard so you can paste it else-
where if you wish.  
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 Paste Button - The Paste Button allows you to paste any item which has previously 
been copied or cut from the text.  
 

 Bold Button - The Bold  Button is a toggle button you allows you to make highlighted 
text bold. When selected text is already bold or the bold button is pressed the button will 
appear in pressed mode. 
 

 Italic Button - The Italic Button is a toggle button you allows you to make highlighted 
text italic. When selected text is already italic or the italic button is pressed the button will 
appear in pressed mode. 
 

 Strike Thru Button - The Strike Thru Button is a toggle button you allows you to 
make highlighted text Strike Thru. When selected text is already in strike thru or the 
strike thru button is pressed the button will appear in pressed mode. 
 

 Underline Button - The Underline Button is a toggle button you allows you to make 
highlighted text Underlined. When selected text is already underlined or the underline 
button is pressed the button will appear in pressed mode. 
 

 Superscript Button - The Superscript Button is a toggle button you allows you to 
make highlighted text Superscript. When selected text is already superscript or the su-
perscript button is pressed the button will appear in pressed mode. 
 

 Subscript Button - The Subscript Button is a toggle button you allows you to make 
highlighted text Subscript. When selected text is already in subscript or the subscript 
button is pressed the button will appear in pressed mode. 
 

 Font Style and Size Drop Down Lists  - 
The Font Style and Size drop down lists allow you to select the font style and size of 
your text. 
 

 Increase and Decrease Font Size Buttons - The Increase and Decrease Font 
Size buttons allow you to change the size of your selected font by one size for every 
press of the button. 
 

 Image Button - The Image button allows you to select and image to insert into the 
text box at the current cursor location.  
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 Centre Text Button - The Centre Text button allows you to centre text within the 
text box  
 

 Left Align Text Button - The Left Align Text button allows you to left align text 
within the text box  
 

 Right Align Text Button - The Right Align Text button allows you to right align text 
within the text box  
 

 Bullet List Button - The Bullet List button converts highlighted text into a bullet text 
list. 
 

 Numbered List Button - The Numbered :List button converts highlighted text into a 
numbered text list. 
 

 Font Colour Button - The Font Colour button allows you to select the colour of the 
text. This applies to both highlighted text and text that you will place in at the current cur-
sor position. When this button is pressed  the colour selection panel is displayed from 
which you may select the desired colour. 
 

 
 

 Font Background Colour Button - The Font Background Colour button allows you 
to select the background colour of the text. This applies to both highlighted text and text 
that you will place in at the current cursor position. 
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5.2.8. TEXT SNIPPETS 

The Text Snippets screen is shown below and allows you to create, store and use 
blocks of text that you may commonly use, called text snippets.  
 

Text Snippets is a single screen which allows for both tree navigation and management 
and item entry and editing all in the same place. 
 

The buttons located at the top of the Text Snippet screen provide the following function-
ality: 
 

• Add: Allows for the addition of either a new library or text snippet, via a drop down 
menu option. 

 

• Delete: Allows for the deleting of either an existing library or text snippet, via a drop 
down menu option 

 

• Rename: Allows for the renaming of either a new library or snippet, via a drop down 
menu option. 

 

• Copy Snippet: Allows for the copying of the current text snippet top the clipboard.  
 
 

 
 

 

The available toolbar items on the Text Snippets form are: 
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 Save Button - The Save Button allows your to sav th text you have entered for the 
current glossary item. 
 

 Undo Button - The Undo Button allows you to undo your previous actions. You may 
press the undo button multiple times to undo multiple actions you have performed in the 
text box. 
 

 Redo Button - The Redo Button allows you to Redo actions you have previously 
undone. You may press the redo button multiple times to redo multiple actions you have 
undone in the text box. 
 

 Copy Button - The Copy Button allows you to copy any item which has been high-
lighted in the text box. . 
 

 Cut Button - The Cut Button allows you to cut any item which has been highlighted 
in the text box. The cut item is also stored on the clipboard so you can paste it else-
where if you wish.  
 

 Paste Button - The Paste Button allows you to paste any item which has previously 
been copied or cut from the text.  
 

 Bold Button - The Bold  Button is a toggle button you allows you to make highlighted 
text bold. When selected text is already bold or the bold button is pressed the button will 
appear in pressed mode. 
 

 Italic Button - The Italic Button is a toggle button you allows you to make highlighted 
text italic. When selected text is already italic or the italic button is pressed the button will 
appear in pressed mode. 
 

 Strike Thru Button - The Strike Thru Button is a toggle button you allows you to 
make highlighted text Strike Thru. When selected text is already in strike thru or the 
strike thru button is pressed the button will appear in pressed mode. 
 

 Underline Button - The Underline Button is a toggle button you allows you to make 
highlighted text Underlined. When selected text is already underlined or the underline 
button is pressed the button will appear in pressed mode. 
 

 Superscript Button - The Superscript Button is a toggle button you allows you to 
make highlighted text Superscript. When selected text is already superscript or the su-
perscript button is pressed the button will appear in pressed mode. 
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 Subscript Button - The Subscript Button is a toggle button you allows you to make 
highlighted text Subscript. When selected text is already in subscript or the subscript 
button is pressed the button will appear in pressed mode. 
 

 Font Style and Size Drop Down Lists  - 
The Font Style and Size drop down lists allow you to select the font style and size of 
your text. 
 

  Increase and Decrease Font Size Buttons - The Increase and Decrease Font 
Size buttons allow you to change the size of your selected font by one size for every 
press of the button. 
 

 Image Button - The Image button allows you to select and image to insert into the 
text box at the current cursor location.  
 

 Centre Text Button - The Centre Text button allows you to centre text within the 
text box  
 

 Left Align Text Button - The Left Align Text button allows you to left align text 
within the text box  
 

 Right Align Text Button - The Right Align Text button allows you to right align text 
within the text box  
 

 Bullet List Button - The Bullet List button converts highlighted text into a bullet text 
list. 
 

 Numbered List Button - The Numbered :List button converts highlighted text into a 
numbered text list. 
 

 Font Colour Button - The Font Colour button allows you to select the colour of the 
text. This applies to both highlighted text and text that you will place in at the current cur-
sor position. When this button is pressed  the colour selection panel is displayed from 
which you may select the desired colour. 
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 Font Background Colour Button - The Font Background Colour button allows you 
to select the background colour of the text. This applies to both highlighted text and text 
that you will place in at the current cursor position. 
 
 
 

5.2.9. PROJECT IDEAS 

The Project Ideas screen is used to enter and store project ideas which may have in re-
lation to your project (or other projects).  
 

The Project ideas screen is shown below and is a single screen which allows for both 
tree navigation and management and item entry and editing. 
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The available toolbar items on the Project Ideas form are: 
 

 Save Button - The Save Button allows your to sav th text you have entered for the 
current glossary item. 
 

 Undo Button - The Undo Button allows you to undo your previous actions. You may 
press the undo button multiple times to undo multiple actions you have performed in the 
text box. 
 

 Redo Button - The Redo Button allows you to Redo actions you have previously 
undone. You may press the redo button multiple times to redo multiple actions you have 
undone in the text box. 
 

 Copy Button - The Copy Button allows you to copy any item which has been high-
lighted in the text box. . 
 

 Cut Button - The Cut Button allows you to cut any item which has been highlighted 
in the text box. The cut item is also stored on the clipboard so you can paste it else-
where if you wish.  
 

 Paste Button - The Paste Button allows you to paste any item which has previously 
been copied or cut from the text.  
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 Bold Button - The Bold  Button is a toggle button you allows you to make highlighted 
text bold. When selected text is already bold or the bold button is pressed the button will 
appear in pressed mode. 
 

 Italic Button - The Italic Button is a toggle button you allows you to make highlighted 
text italic. When selected text is already italic or the italic button is pressed the button will 
appear in pressed mode. 
 

 Strike Thru Button - The Strike Thru Button is a toggle button you allows you to 
make highlighted text Strike Thru. When selected text is already in strike thru or the 
strike thru button is pressed the button will appear in pressed mode. 
 

 Underline Button - The Underline Button is a toggle button you allows you to make 
highlighted text Underlined. When selected text is already underlined or the underline 
button is pressed the button will appear in pressed mode. 
 

 Superscript Button - The Superscript Button is a toggle button you allows you to 
make highlighted text Superscript. When selected text is already superscript or the su-
perscript button is pressed the button will appear in pressed mode. 
 

 Subscript Button - The Subscript Button is a toggle button you allows you to make 
highlighted text Subscript. When selected text is already in subscript or the subscript 
button is pressed the button will appear in pressed mode. 
 

 Font Style and Size Drop Down Lists  - 
The Font Style and Size drop down lists allow you to select the font style and size of 
your text. 
 

  Increase and Decrease Font Size Buttons - The Increase and Decrease Font 
Size buttons allow you to change the size of your selected font by one size for every 
press of the button. 
 

 Image Button - The Image button allows you to select and image to insert into the 
text box at the current cursor location.  
 

 Centre Text Button - The Centre Text button allows you to centre text within the 
text box  
 

 Left Align Text Button - The Left Align Text button allows you to left align text 
within the text box  
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 Right Align Text Button - The Right Align Text button allows you to right align text 
within the text box  
 

 Bullet List Button - The Bullet List button converts highlighted text into a bullet text 
list. 
 

 Numbered List Button - The Numbered :List button converts highlighted text into a 
numbered text list. 
 

 Font Colour Button - The Font Colour button allows you to select the colour of the 
text. This applies to both highlighted text and text that you will place in at the current cur-
sor position. When this button is pressed  the colour selection panel is displayed from 
which you may select the desired colour. 
 

 
 

 - Font Background Colour Button - The Font Background Colour button allows 
you to select the background colour of the text. This applies to both highlighted text and 
text that you will place in at the current cursor position. 
 
 
 
 
 

5.3. TOOLS TAB 
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The Tools tab provides access to tools such as template  builder and task list tracker. 
The Tools tab is shown in the image below. 
 
 
 

 
 
 

The Tools Tab Contains 5 main groups and 9 buttons, these being: 
 

General Templates 

 

• Character Profile 

 

• Event Sequence 

 

Location Types 

 

• Location Types Templates 

 

• Location Types 

 

Object Types 

 

• Object Type Templates 

 

• Object Types 

 

Notecards 

 

• Notecard Templates 

 

• Notecard Types 

 

Tools 

 

• Task List 

5.3.1. CHARACTER PROFILE TEMPLATES 

When you create new Characters within the My Novel Writer application then you can 
also nominate to use a character template which then provides you with an initial char-
acter profile structure. 
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The Manage Character Profile Templates screen is shown below. Using this screen you 
can select and edit existing templates, add new templates, rename templates and delete 
templates which you no longer need.  
 

The text editor in the center of the screen and the editor toolbar located above it allow 
you to create formatted text for you Character Template. 
 

 
 
 

5.3.2. EVENT SEQUENCE TEMPLATES 

When you create new Event Items within the My Novel Writer application then you can 
also nominate an event sequence template which will then provide you with an initial 
event structure. 
 

The Manage Event Sequence Templates screen is shown below. Using this screen you 
can select and edit existing templates, add new templates, rename templates and delete 
templates which you no longer need.  
 

The text editor in the center of the screen and the editor toolbar located above it allow 
you to create formatted text for you Event Sequence Template . 
. 
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5.3.3. LOCATION TYPE TEMPLATES 

When you create new Locations within the My Novel Writer application you can also 
nominate to use a Location Template to help define and format the presentation of the 
the location information. 
 

Location Type Templates are managed from within the My Novel Writer application us-
ing the Manage Location Template screen, as show below. Using can use this screen to 
add, rename or delete Location Type Templates and to format the text of the template 
using the text editor and the editor toolbar located above it. 
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5.3.4. LOCATION TYPES 

The Location Types screens allows you to create different types of Locations. Each Lo-
cation Type has an allocated Location template which provides the location with an initial 
text structure. The Manage Location Types screen is shown below. 
 

When you later create locations for your book you can allocate location types to each lo-
cation and this in turn will provide an initial text structure to your location item..  
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5.3.5. OBJECT TYPE TEMPLATES 

When you create new object items within the My Novel Writer application, such a a pi-
rate ship or a planet or even a human, then you may also nominate to use an Object 
Template to define what that object looks like.. 
 

You can create and manage the Object Templates using the Manage Object Template 
screen, as show below. Using this screen you can add, rename or delete Object Tem-
plates. You can also enter the text for the structure of your object using the text area in 
the middle of the screen. You can format this text using the editor toolbar located above 
the text entry area. 
 



My Novel Writer - (version 2.0)  Page 50  

 

5.3.6. OBJECT TYPES 

The Object Types screen allows you to create, rename and delete Object Types within 
your book. The Manage Object Types screen is shown below.  
 

 When you create a new Object Type you also need to nominate which Object Type 
Template to allocate to this item so that the Object Type has a predefine textural defini-
tion. 
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5.3.7. NOTECARD TEMPLATES 

The Manage Notecard Templates screen allows you to create, rename and delete Note-
card Templates, as shown in the image below.  
 

The Notecard templates are used to provide predefined textural structures for the Note-
cards you create for your book. When you create a new Notecard Template you can use 
the text editor section in the middle of the screen to enter your template structure and 
the editor toolbar above the editor to format the text.  
 
 



My Novel Writer - (version 2.0)  Page 52  

 

5.3.8. NOTECARD TYPES 

The Notecard Types screen allows you to create, rename and delete the various differ-
ent types of Notecards which you will use within your application. The Notecard Types 
screen is shown below.   
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For each Notecard Type you create you must nominate: 
 

• a Display Title  
 

• a Notecard Type  
 

• a Notecard template 

 

The Add New Notecard Type screen is shown below. . 
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After you have created the various different Notecards for your book then they will ap-
pear along the bottom of the Page Editor screen when you open each of the pages 
within your book, as shown below. As you add information into the Notecards this infor-
mation will be saved on a page-by-page basis.   
 
 

 

5.3.9. TASK LIST 

The Task List screen is shown below. Using this screen you to add, manage and track 
the tasks you need to work on during your book project.  
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The Tasks List screen allows you to place your task items into different categories and 
set then to different statuses and categories as you work through them. You can defined 
these values using the Status Items and Category Items screens found in the Admin-
istration Tab.  
  
 

 
 

There are three sets of buttons available on the Task form; one for managing the Tasks 
Lists, one for managing the task items and one for saving and updating the task item. 
 

Creating and Managing Task Lists and Task Items Toolbar 

 

This toolbar and button set is shown below. There are a number of buttons available on 
this toolbar which allow you to add and manage task lists and also to add and delete 
task items. 
 

 
 

 
 

Saving and Updating The Task Item 

 

This toolbar and button set is shown below. There are two buttons on this toolbar; one to 
save the existing task and one to set the task to completed. 
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5.4. ADMINISTRATION TAB 

The Administrations tab provides access to the systems options and user management 
areas a well at management iof task status and categories lists. The Administration tab 
is shown below. 
 

 
 
 

The Administration Tab Contains 3 main groups and 7 buttons, these being: 
 

Users 

 

• System Options 

 

• Manage Users 

 
 

Manage Task lists 

 

• Task Status 

 

• Task Category 

 
 

Form Configuration 

 

• Manage Forms 

 

• Form Fields 
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• Tool Tips 

 
 
 
 
 
 
 

 

5.4.1. MANAGE USERS 

The Manage Users screen is shown below and allow you to manage all users who have 
access to the My Novel Writer application. 
 
 

 
 
 

There are a number of buttons across the bottom of this form, these being: 
 

Add User Button: The Add User button allows you to add a new user to the My Novel 
Writer application. When the Add User button is pressed then the Add New User screen 
is  displayed.  
 

This screen allows you to add new users to the My Novel Writer application, including 
whether or not their account is active. 
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Edit User Button: The Edit User button allows you to edit an existing user of the sys-
tem. When you select the edit user function the user details will be displayed in the Edit 
User screen and you will be able to change and save the update user details. 
 

Delete User Button: The Delete User button allows you to remove users from having 
access to the My Novel Writer application. When you select to Delete User button you 
will first be prompted as to whether or not you wish to delete this user. If you select Yes 
then the user will be deleted from the application.  
 

Note that you are unable to delete the My Novel Writer Admin user account.  

5.4.2. MANAGE TASK STATUS 

The Manage Task Status screen is shown below. You can use this screen to add, edit 
and delete task status items from the applications 
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5.4.3. MANAGE TASK CATEGORIES 

The Manage Task Categories screen is shown below. You can use this screen to add, 
edit and delete task category items within the applications 

 

 

5.4.4. MANAGE FORMS 
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The Manage Forms screen is shown below and allows you to customise all the Form Ti-
tles within the My Novel Writer application. This screen is accessed from the Form Con-
figuration  button group.. 
 

 
 

 
 
 

The Manage Forms screen contains a list of all the available applicatrion screens and 
has three buttons along the bottom of the screen, these being; 
 

• Edit Form Title: The Edit Form Title button, when pressed, opens the Edit Form Title 
screen. This screen allows you to edit the form title. Pressing the Save button will save 
the new form title to the database, while pressing the Cancel button will discard any 
changes made and close the Edit Form Title screen. 

 

• Reset To Default: The Reset To Default button, when pressed, resets the name of the 
selected Form to the default form name, as shown in the last column of the table.  
 

• Close: The Close button, when pressed, closes the Manage Forms screen. 

5.4.5. FORM FIELDS 

The Manage Form Fields screen is shown below and allows you to customise all the 
Form Field Labels within the My Novel Writer application. This screen is accessed from 
the Forms button group. 
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The Manage Forms screen contains a drop down list of available Form names at the top 
of the screen, a list of all the available field names for the selected Form Name in the 
centre of the screen and three buttons along the bottom of the screen. 
 

By first selecting the form name at the top of the screen then all available form fields for 
that specific form are displayed in the form fields list in the centre of the screen. The 
form field list includes columns for the Field Name, Current Field Label Value and the 
Default Field Label Value.   
 

Additional form functionality can be obtained using the three buttons available at the bot-
tom of the form: 
 

• Edit Label: The Edit Label button, when pressed, opens the Edit Form Label screen. 
This screen allows you to edit the selected form label. Pressing the Save button will 
save the updated form label to the database, while pressing the Cancel button will dis-
card any changes made and close the Edit Form Label screen. 

 
 

• Reset Default Value: The Reset To Default Value button, when pressed, resets the 
name of the selected Form Form Field to the default Form Field Name, as shown in 
the last column of the table.  
 

• Close: The Close button, when pressed, closes the Manage Forms screen. 
 
 

5.4.6. TOOL TIPS 
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The Tool Tips Configuration screen allows you to customise all the Form Field Tool Tips 
within the My Novel Writer application. This  screen is accessed from the Forms button 
group. 
 
 

 
 
 
 

The Configure Form Field Tool Tips screen contains a drop down list of available Form 
Names at the top of the screen, a list of all the available field names for the selected 
Form Name in the centre of the screen along with the current and default tool tips for 
each field and three buttons along the bottom of the screen. 
 

By first selecting the form name at the top of the screen, all the available form fields for 
that specific form are displayed in the Tool Tips list in the centre of the screen. The list 
includes columns for the Field Name, Current Tool Tip Value and the Default Tool Tip 
Value.   
 

Additional form functionality can be obtained using the three buttons available at the bot-
tom of the form: 
 

• Edit Tool Tip: The Edit Tool Tip button, when pressed, opens the Edit Form Field Tool 
Tip screen. This screen allows you to edit the selected form field tool tip. Pressing the 
Save button will save the updated tool tip to the database, while pressing the Cancel 
button will discard any changes made and close the Edit Form Field Tool Tip screen. 

 

• Reset To Default: The Reset To Default Value button, when pressed, resets the Tool 
Tip of the selected Form Form Field to the default Tool Tip, as shown in the last col-
umn of the table.  
 

• Close: The Close button, when pressed, closes the Configure Form Field Tool Tips 
screen. 
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5.5. EXTERNAL TOOLS TAB 

The External Tools Tab allows you to access and configure external tools which may 
then be access from the My Novel Writer External Tools tab, as shown in the image be-
low.  
 
 

 
 
 

By default both the Notepad and Calendar external application are already provided for 
you, along with access to Microsoft Word, Excel and Outlook if they're installed on your 

machine. 
 

The Manage External Items button open the Manage External Items screen which al-
lows you to add and manage external tool items. 

5.5.1. MANAGE EXTERNAL ITEMS 

The Manage External Tools screen allows you to add and delete external tool items from 
My Novel Writer . 
 

The Manage External Tools screen is shown below, along with a more detailed func-
tional description. Note that all changes you make to the External Tools set wont be ap-
plied until you log into the My Novel Writer application again. 
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Add User Tool Button - The Add User Tool button allows you to add a new external 
tool. When pressed the Add User Tool screen is displayed, as shown below.Using this 
screen you must provide a unique Tool Name, the path to the tool and an icon by which 
the tool  will be displayed in the My Novel Writer ribbon bar,  
 

 
 

Edit User Tool Button - The Edit User Tool button allows you to edit existing external 
tool items. 
 

Delete User Tool Button - The Delete User Tool button allows you to remove selected 
external tool items from the external tool set. 
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